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READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS BOX.

BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE

SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE USER

MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN THE SOFTWARE TO

YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions

of this Agreement.

1. LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be downloaded
to the applicable Canon digital camera product, Canon grants you a personal, non-exclusive license to use
the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a-hard disk) of your computer and retain the original for
back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement. You must
reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for
providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be made
available for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain and
match the hardware and software components of your computer system. Thus Canon does not guarantee
uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet
your requirements. THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR
CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same
without charge when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The Replacement CD-ROM will be warranted for the remainder of the original ninety (90)
day warranty period of the defective CD-ROM. The limited warranty does not apply if the failure of the CD-
ROM resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other
than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE FOR
ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT,
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE OR
INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL HAVE
ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A THIRD PARTY
ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY INTELLECTUAL PROPERTY
OF SUCH THIRD PARTY.



SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED
WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE ON
THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY TO
YOU.

. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of

all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this Agreement by

destroying the SOFTWARE. This Agreement will also terminate without notice to you if you fail to comply
with any of the terms of this Agreement and you must then promptly return the SOFTWARE. In addition,
Canon may enforce its other legal rights.

. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:

The SOFTWARE is a “commercial item,” as that term is defined at 48 C.FR. 2.101 (Oct 1995), consisting of
“commercial computer software” and “commercial computer software documentation,” as such terms are
used in 48 C.FR. 12.212 (Sept 1995). Consistent with 48 C.FR. 12.212 and 48 C.F.R. 227.7202-1 through
227.72024 (June 1995), all U.S. Government End Users shall acquire the SOFTWARE with only those rights
set forth herein. Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501,
Japan.

. EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and regulations of the

country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of any such
laws and restrictions and regulations, or without all necessary approvals.

. SEVERABILITY:

In the event that any provision of this Agreement is declared or found to be:illegal by any court or tribunal of
competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or
tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the United

States of America shall be governed and construed in all respects in accordance with the laws and
regulations of the State of New York, without reference to choice of law principles. The terms of this
Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of the
province of Ontario.

10.OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE

1

jry

belong to Canon, its affiliated corporations and third party licensors. Your use of the SOFTWARE is subject to
the laws of the United States, and Canada, and other applicable copyright and trademark laws, and nothing
in this Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party
licensors under such laws. You only own the CD-ROM media in which the Software is stored. Except as
expressly provided herein, no license or right, express or implied, is hereby conveyed or granted by Canon to
you for any intellectual property of Canon. Nothing contained in Paragraph 1 shall be construed to give
Canon any ownership rights in any images, graphics or textual material that you save in connection with the
Software.

You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of a back-up copy
made pursuant to Section 2 above.

.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ

THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.
YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED
OFFICER OF CANON.
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Read This First

You can connect a camcorder to the computer using a USB cable to download
still images recorded on the memory card of the camcorder. You can also use
the provided software to sort, store, and print still images.

Disclaimer

e While every effort has been made to ensure that the information contained
in this guide is accurate and complete, no liability can be accepted for any
errors or omissions. Canon reserves the right to change the specifications of
the hardware and software described herein at any time without prior
notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in
a retrieval system, or translated into any language in any form, by any
means, without the prior written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost
data due to mistaken operation or malfunction of the camcorder, the
software, memory cards (MultiMediaCards or SD Memory Cards), personal
computers, or peripheral devices, or due to use of.a memory card not
formatted by a Canon camcorder.

Trademark Acknowledgments

e Canon is a registered trademark of Canon Inc.

* Macintosh is a trademark of Apple Computer Inc., registered in the United
States and other countries.
QuickTime is a trademark of Apple Computer, Inc.

¢ Microsoft®, Windows® and Windows Media® are either registered
trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries.

e Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.

Copyright © Canon Inc. 2003 All rights reserved.

Safety Precautions

Do not play the supplied CD-ROM(s) in any CD player that does not support
data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss from
listening with headphones to the loud sounds of a CD-ROM played on a
music CD player.



Use the following accessories to download recorded images from a memory
card to your computer.
e |[FC-300PCU USB Cable

Checking Supplied Accessories E

e DIGITAL VIDEO SOLUTION DISK

e Windows users: Move on to p. 8.
e Macintosh users: Move on to p. 60.

The explanations in this manual use mainly Windows 98 and Mac OS 9.2
screen shots.




System Requirements

Please install the software on a computer meeting the following minimum
requirements.

OS: Windows 98 (First or Second Edition)
Windows Me
Windows 2000
Windows XP (Home Edition, Professional)
* Proper operation is not guaranteed on an OS that
has been upgraded from a previous version.

Computer Model: Computers that come with above OS preinstalled
and have built-in USB ports.
CPU: Windows 98/Windows Me/Windows 2000: Pentium

150 MHz or better
Windows XP: Pentium 300 MHz or better

RAM: Windows 98/Windows Me/Windows 2000: 64 MB or more
Windows XP: 128 MB or more

Interface: USB: only preinstalled Windows 98/Windows Me/
Windows 2000/Windows XP systems with built-in
USB ports

Free Hard Disk Space: e Canon Utilities
— ZoomBrowser EX: 120 MB or more (Including the
PhotoRecord printing program)
— PhotoStitch: 40 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more
Display: 800 x 600 pixels/High Color (16 bit) or better,
1,024 x 768 pixels or better is recommended

VG‘ O The USB interface is only supported for those computers that come
¥  with Windows 98/Windows Me/Windows 2000/Windows XP
preinstalled and have built-in USB ports.

O Proper operation is not guaranteed.on a dual CPU PC or on a user-
built PC.

O Proper operation is not guaranteed on any particular system, even if
it meets the requirements outlined above.

O A CD-ROM drive is required to install the software.

O Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

O Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

O Not all operations performed with a connection to a USB 2.0
compatible board can be guaranteed.



What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the DIGITAL VIDEO SOLUTION DISK. [E]

H TWAIN Driver (11 14)
TWAIN Driver is the driver software for Windows 98 and Windows 2000
that is required for downloading still images/movies from a memory card to
a computer.

B WIA Driver (11 15)
WIA Driver is the driver software for Windows Me and Windows XP that is
required for downloading still images/movies from a memory card to a
computer.

B ZoomBrowser EX (11 17)
¢ Downloading still images/movies from a memory card to your computer.
e Categorizing and organizing large volumes of images.
e Creating mail attachments from images. (Your e-mail program needs to
be enabled as MAPI client.)

H PhotoRecord (1] 33)
e Laying out and printing still images.
e Printing indexes.
e Creating still image albums.

B PhotoStitch ([0 41)
Merging Panoramic Images.

This instruction manual explains how to install the software, what you can do
with the main features and how to operate them. For more detailed
perational instructions, refer to the Help menu of each software program.
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Installing the Software
Installing from the DIGITAL VIDEO SOLUTION DISK

VG O Before you attach the camcorder to the computer with the USB
¥  cable for the first time, you must install one of the following drivers
onto the computer.
Windows 98/Windows 2000: TWAIN Driver (I3 14)
Windows Me/Windows XP: WIA Driver (00 15)
O Users of Windows 2000 or Windows XP must first log in as an
Administrator to install programs.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK in the computer’s CD-
ROM drive.

¢ The installer panel opens automatically.
e If the installer panel does not appear automatically, use the following
procedures to display it.
Windows 98, Windows Me, Windows 2000:
1. Double-click the [My Computer] icon.
2. Right-click the CD-ROM icon and select [Open] from the displayed
menu.
3. Double-click the [Setup.exe] icon.
Windows XP:
1. Select [My Computer] from the [Start] menu.
2. Right-click'the CD-ROM icon and select [Open] from the displayed
menu.
3. Double-click the [Setup.exe] icon.
Depending on the setting of your computer, the file extension “.exe”
may not appear.

3. Select your language.

4. Click [Digital Video Software Installation].

Canon

# Digtal Viiso Softmars lnitallation

@ Husck Time 5,0 nstallation

Installer Panel

DIGITAL VIDEO

SOLUTION DISK e



5. Click [Next].

Welcome Lo the InslallSheeld Wizard for Solubon
sk

The Instalisheeld® Wizaed wll nstall Sobhon Disk on pour
womgabe. 1o conlre. cick, Nesd

Canan Digital Videa Solution Disk E

6. Read the license agreement and click [Yes].

7. Confirm the installation destination and click [Next].
Normally, select (C:\Program Files\Canon).

Canan Digital Videa Solution Disk
Chonse Destination | ncation
Slert folder whetr Seiup vl noal fles.

8. select the programs you wish to install and click [Next].
Confirm that there is a check mark beside the name of the program you

wish to install.

olution Disk

Chaase the Inahaes Setup vl ratal

Seloct e R e

@ Phrestich | Descrioten

oA ooniBiov EXFholoRecod An application that.

] Canon Camena TN Dirven W:ﬁmﬁﬂm

parreana
Spece lequred on C: 165 MB
Sbm_ frvadaie on C T ME
s (D e |

1
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Installing the Software

9. select your camcorder model name and click [Next].
Place a check mark beside your camcorder model name.

Canan Digital Video Solution Disk

Select Features
Select the options wou wank to inital

Lok | _cosn |
g pot> ) cocu |

10. Review the installation settings and click [Next].
Installation starts.

Canon Digital Viden Solution Disk

Start Copging Files
Fiikien ttings bioie copying fle:.

hmlm
shgme oy el

11. When the following window appears, click [OK].

This window only appears if you installed the TWAIN Driver or the WIA
Driver.

e recuied s o yona compader.

O

The rest of th 4 *




12. When installation is complete, select [Yes, | want to restart
my computer now.] and click [Finish].

InstallShield Wizard Complete

i Stk Wizand Sahlon
Dick. Eelore pou can use the pogiam. pou must iestart your
T
& ez, | wand in inskart my compuler e
© o, | vell vt emy commpulen later.

Chick. Finith to complete 1ehup.

13. When the computer has restarted and the regular desktop
screen is displayed, remove the DIGITAL VIDEO SOLUTION
DISK from the CD-ROM drive.

05 O When installation is complete, remove the DIGITAL VIDEO SOLUTION
= DISK before you connect the camcorder to the computer.
O At this point, the files for the TWAIN Driver or WIA Driver have only
been copied to your computer. To download still images/movies via
USB connection, finish installing the TWAIN driver or the WIA driver.

13
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Installing the Software

Installing the TWAIN Driver/WIA Driver

When you have installed the software from the DIGITAL VIDEO SOLUTION
DISK, go on to install the TWAIN Driver or the WIA Driver.

Windows 98/Windows 2000

TWAIN Driver

TWAIN Driver is the driver software for USB connection to Windows 98 and
Windows 2000 that is required to download still images/movies into
ZoomBrowser EX.

’0\ Users of Windows 2000 must first log in as an Administrator to install
\&¥ the driver.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY.(VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable ([1] 16).

o After a few moments, a message such as “New Hardware Found”
appears and the TWAIN driver will be installed automatically.

e If you are prompted to restart the computer, restart the computer.

e When installation is complete, a window appears allowing you to select
an application program to start.
See Downloading Still Images/Movies (1 17) for how to start
ZoomBrowser EX and download still images/movies to the computer.



Windows Me/Windows XP

WIA (Windows Image Acquisition) Driver IE'
WIA Driver is the driver software for USB connections to Windows Me and

Windows XP that is required to download still images/movies into

ZoomBrowser EX.

mm\ O Read carefully before installing the WIA Driver:

QA When you have set the WIA Driver to start a particular application
program when you connect the camcorder, the program may cause
an error message similar to the following to appear: “TWAIN data
source not found. Reinstall the scanner software.” If this happens,
select [WIA-camera model] in the application program as the TWAIN
device.

O Users of Windows XP must first log in as an Administrator to install
the driver.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable ((1] 16).

o After a few moments, a message such as “Found New Hardware"”
appears and the WIA driver will be installed.

e If you are prompted to restart the computer, restart the computer.

¢ Windows Me: When installation is complete, the Scanners and Cameras
Wizard starts.
See Downloading Still Images/Movies (1 18) for how to start
ZoomBrowser EX and download still images/movies to the computer.

e Windows XP: When installation is complete, a window appears
allowing you to select an application program to start.
See Downloading Still Images/Movies ([ 17) for how to start
ZoomBrowser EX and download still images/movies to the computer.

Windows XP: If a window appears prompting you to select an

M application program to start, select ZoomBrowser EX or Scanners and
Cameras Wizard to start. If neither of these is selected, operation may
not work correctly. You can also set the computer to start ZoomBrowser
EX or Scanners and Cameras Wizard automatically (@3 52).

15



Connecting the Camcorder to a Computer

VG\ O Make sure the camcorder is being powered using the power adapter
¥4  before connecting it to a computer.

O Be sure to install the DIGITAL VIDEO SOLUTION DISK before you
connect the camcorder to the computer.

O Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

O Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

O Never allow the computer to go into standby (sleep) mode while
a camcorder is connected via the USB interface. If it does happen,
never disconnect the USB cable. Try to awaken the computer with
the camcorder in the connected state. Some computers will not
awaken properly if you disconnect the camcorder while they are
in standby mode. Please refer to your computer manual for
instructions regarding its standby mode.

1. Insert a memory card into the camcorder.

2. Connect the power adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4. Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
¢ You do not need to turn off the.computer for this procedure.
e Refer to your computer manual for the location of the computer’s USB ports.
¢ See your camcorder instruction manual for connecting instructions.

USB Terminal USB Cable
on the Camcorder

E k= | g = 5]

~4— Camcorder End Computer End —»

USB Port on
the Computer

The first time you connect the camcorder to the computer via USB
16 4 interface, install the TWAIN Driver or the WIA Driver ((n 14,15).



Downloading Still Images/Movies (ZoomBrowser EX)

Below explains the procedure for connecting a camcorder to a computer using
the USB cable. For connecting a PC card reader/writer, see Using a PC Card |E|
Reader/Writer ( 21).

@ O Observe following precautions when the camcorder’s card access
\ ¢ /] indicator is flashing (the camcorder is reading or writing from or to
the memory card). Failure to do so may cause memory card data to
become corrupted.
— Do not remove the memory card or detach the USB cable.
— Do not turn off the camcorder or the computer.
— Do not change the position of the POWER switch or the TAPE/
CARD switch.

O Format the memory card with the camcorder or from the Camera
Window (M 23).

O Still images/movies recorded onto the memory card or downloaded
to the hard disk are important original data files. Create a copy of
the file first before working on it on your computer.

O When an enormous volume of still images/movies (such as 500 or
more) is recorded onto one memory card, transferring them to a
computer may take very long.

O For Windows XP Users:

Do not rotate the image:in the [Windows Picture and Fax Viewer] or
in the explorer view. The file format of the original image will be
changed and the image can no longer be displayed in ZoomBrowser
EX or on the camcorder.

For instructions on how to set ZoomBrowser EX to start automatically,
see page 50.

O
g

StﬂtiﬁZoomBﬁwser EX

Windows 98/Windows 2000/Windows XP

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

17
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Downloading Still Images/Movies (ZoomBrowser EX)

4.

5.

Connect the camcorder to the computer using the supplied
USB cable (1] 16).

After a few moments, a window appears allowing you to select an
application program to start.

Select [Canon ZoomBrowser EX] and click [OK].

e ZoomBrowser EX starts and opens the Camera Window, displaying the
camcorder images as thumbnails (small images).

e |[f a camcorder and PC card reader are connected at the same time, a
window appears allowing you to select the camcorder model. Confirm
that your camcorder model name is displayed and click [OK].

FV40, ZR70 MC event HE

% Pl diramar e s et

receive the image.

Cancel |

Windows Me

Insert a memory card containing still images/movies into the
camcorder.

Connect the Power Adapter to the camcorder.

Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wiait until the card access indicator stops flashing.

Connect the camcorder to the computer using the supplied
USB cable ([T] 16).

The Scanners and Cameras Wizard automatically opens. Click [Cancel] to
close the Wizard.

Double-click the [ZoomBrowser EX] icon on the desktop.
ZoomBrowser EX starts and the Main Window appears.




B[] Daskice
o] g My Documents
B My Computer
Baa )
Ba 10
By E]
B =) Removable Disk [F ]
{2 Orfre Sesvices

7. Click [Browse and Download Images].

The Camera Window opens, displaying the memory card images as
thumbnails (small images).

B[} Deoskicp
5 (55 My Docuenents
£ 5 My Comgater

Bay [E
=) Removable Disk (F:)

|4 Driing Sevvices ‘I

Upload Images | |

Downloading Still Images/Movies to the Computer

1. In the Camera Window, select the still image/movie you
wish to download and click [Download image].
e An orange frame appears around the selected still image/movie.

¢ You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

Came:awinduw

& Memorp Card

200211409
16:15:38
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Downloading Still Images/Movies (ZoomBrowser EX)

2. In the Download Settings window, confirm the settings and
click [OK] (O 23).




Using a PC Card Reader/Writer

This section explains only the instructions which differ when connecting a PC
Card Reader/Writer instead of the camcorder.
For instruction on how to connect the PC Card Reader/Writer, please refer to

its manual.

1. Insert a memory card into the reader.

2. Windows 98/Windows 2000/Windows Me: Double-click the
[ZoomBrowser EX] icon on the desktop.

Windows XP: When a window appears allowing you to
select an application program to start, select [ZoomBrowser
EX] and click [OK].

ZoomBrowser EX starts.

4. Click [Browse & Download Images].

e The Camera Window opens, displaying the memory card images as
thumbnails (small images).

e |f multiple PC.card readers loaded with memory cards are connected or
if a camcorder and a PC card reader are connected, a selection dialog
will appear before the Camera Window opens. Select one of the
devices to proceed and click [OK].

da 5 B B @ 6
oo
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Using Other ZoomBrowser EX Functions

Camera Window

The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images (Movies are
displayed with the first scene as a still image, indicated with a movie icon).
Buttons are activated when a still image/movie is selected.

Thumbnails
Indicates that it has been Still images and movies are
downloaded to a computer. displayed in reduced size.

Lamera & Memoty Lard

—\

2
— m ﬁ

0 T T

Cumnrert {u intesned 9 = : = { l_‘*-
iy 2N Dud Prets,

Fini e

Task Area Toolbar
Task Area
[Download image]: . Downloads selected still images/movies to the
computer.
[Print]: Prints selected still images. Menu options: Layout

Print and Index Print.

[View as slideshow]: Starts a slide show after downloading the selected
still images/movies to the computer.

[Connect to Internet]: Attaches selected still-images to an e-mail message.

Toolbar

[Set]: Adjusts the connection settings and camcorder settings. Menu
options: Reconnect, Camera Settings, Slide*/DPOF, Add Image(s) and
My Camera*. (*The SLIDE/My Camera ({73 47) function cannot be used.)

[Select]: Selects still images/movies. Menu options: Select All, Select
New, Select Print mark, Select Send mark, Select Slide Show
mark and Invert Selection.

[Deselect]: Deselects still images/movies.

[Rotatel]: Rotates still images. Menu options: 90 degree left, 90 degree
right and 180 degree.

[Delete]: Deletes selected still images/movies.

[Properties]: Displays image information (such as shooting date/time and
image size).

[Help]: Displays help topics.



Download Settings Window

The following window appears when you select a task in the Task Area of the
Camera Window.

Domolvad Setti: ________________H]

Sebs up image downlaading

Save bo bokdar
Select a folder in which you wish to [y Docments frome__|
download and save the still image/movie. Dk crmale news folder

% Creale new lokder

‘Folder name: = Shooting date

If you wish to create a new folder, select © Dovinloaded doto
[Create new folder] and select the item )
you wish to use as folder name. [

™ Desigistes prefi of ir to be caved
If you leave the box without check mark, —E Fils el - E——
the folder will be named in the form of
“100-0001.JPG". o |
If you put a check mark in the box, you 4

can designate a file prefix. The folder will
be named “file prefix + 0001.JPG".

Camera Settings Window

You can adjust the date, time and owner settings in the Camera Settings
window using the computer when the camcorder is connected. You can also
check the battery charge and remaining memory card capacity.
1. In the Camera Window, click the [Set] button and select [Camera Settings]
from the displayed menu.
2. Check or change the settings.
Click [OK] to close the window.

Input a camcorder owner name here EE o DD
(up to 31 characters). | Frmare Ve 1,000
Owners Nome:
|

Set the date and time here.

MJA Time

Click this button to synchronize the [@ 7o ram[o. o7 M = i
camcorder to the computer’s date e . -
and time settings. e |'i
Check the battery status here. o Foms |
Sthar Irstalied
ini E 530 Mo
Check the remaining memory card ———— i

capacity here.

Click this to format the memory card
in the camcorder. [ - |
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Using Other ZoomBrowser EX Functions

Main Window

ZoomBrowser EX's Main Window features various buttons and an image
display area. This section introduces the names and functions of the various

window parts.

Clicking €3 hides the area.

Click % again to redisplay the area.

Toolbar

o 2w 11_08
{1 My Pichaes

1 My Comouer
@iz (€]

=3 (0]

Bl E]

[ (= Fremevsble Dok F]

(23 Orérre Sevrices

- 4
Task Area Folders Area Browser Area
Select image folders here. As in Displays the images
Windows Explorer, you can view contained in the
the contents of the folders. selected folder.

Task Area (Main Menu)

[Camera & Memory Card]: Displays the Camera Window.

[Print]:

[View & Modify]:

[Internet]:

Prints selected still images. Menu options: Layout
Print and Index Print

Use this to view or edit images. Menu options:
View as a Slide Show, Edit Image and Stitch
Photos.

Attaches selected still images to an e-mail
message.



Toolbar
[View Model:

[Thumbnail Sizel:

[View Image]:

[Properties]:

[Rotatel:
[Deletel:

Switches between the Zoom Mode and Scroll Mode. IE
Scroll Mode:

Displays the images in the selected folder at a large, easy-
to-view size. When there are more images than can fit in
the Browser Area, a scroll bar appears at the right of the
Browser Area. When a folder has been created within the
selected folder, the folder appears as an icon.

Zoom Mode:

When a folder has been created within a folder, it displays all
images within the nestled folder. Selecting the magnifying
glass (+ or —) and clicking a folder or an image in the Browser
Area changes the size at which an image is displayed or the
folder level. You can also zoom up by double-clicking an
empty part of the Browser Area or the tab of a folder name.
Selects the size at which images are displayed in the Browser
Area. Menu options: 80 x 80, 160 x 160 and Column Number.
It can only be selected in [Scroll Mode].

Displays a still image in the Image Viewer window, or
opens a window for playing back a movie.

Displays image information (such as shooting date/time
and image size).

If you select an‘image in the Browser Area while the
Properties window is open, the information in the window
switches to the contents of the selected image.

CRENT

2 Modified: 11102
||'Z Fie Siam: T0TKE
Y Image Size: 640y 480
‘ File Type: "

Palh ¢y dotusmertsny e,

Fibe Name:
1000

Lot
You can change the file name J_—]

or enter a comment. J 7 E
Shosken Indomation.

Shecobing O me
1149702 41504 PH
Imace Size
Ol 00

this button when more than

Switch between images with —| Fie i
one image is selected.

|

T A
Rotates selected still images.

Deletes selected still images/movies.
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Using Other ZoomBrowser EX Functions

Image Viewer Window

The Image Viewer window appears when you double-click a still image, or
when you select a still image and click [View Image].

|ﬂ iy documents imy plctures H00_0001 jpg - T0% - ol

Zoom Color, Brightness and Contrast

You can change  You can adjust the color,

the zoom ratio. brightness and contrast by
dragging the respective slide.

Crop

You can extract a part of the image.

1. Click on the image and drag to form a rectangular frame.
You can move or change the size of the frame.

2. Click this button to extract the area within the frame.
The extracted part of the image appears.



In the Camera Window and Main Window, movies are displayed with the first

scene as a still image with a movie icon (& ). When you double-click the IE
thumbnail in the Main Window, QuickTime Player starts and plays back the

movie.

O If QuickTime 3.0 or a later version is not already installed on your
computer, install the QuickTime 5.0 program from the DIGITAL
VIDEO SOLUTION DISK. Place the disk in the CD-ROM drive and
click [QuickTime 5.0 Installation] in the installer panel.

O Do not double-click a movie file ((AVI extension) in Windows
Explorer. That will start Windows Media Player, which may not
support this file type. To play back movies, double-click the
thumbnail with a movie icon in the Main Window's Browser Area.

1. In the Main Window, double-click a thumbnail with a [
(movie) icon.

QuickTime Player starts.

2. Click the > (play) button in QuickTime Player.
The movie will be played back.

101 0128, 3 — %
Hie Edt Move UIY Window Helo :

T
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You can view selected still images in a slide show. Movies cannot be selected
for a slide show.

1. Click [View & Modify] in the Main Window.

2. d

Foeuen o s Mees [ ]




4. select the slide show settings. IE

e [Image Size]: Select the size of the still images.

¢ [Image Information]: Select to show image information such as file
name or title.

¢ [Advance to Next Slide]: Select to advance manually or automatically.
When you select “Every 3 seconds”, you can select the interval in the
control below (from 1 to 120 seconds).

e [Loop]: Select to stop the slide show after the last image or to
continuously run it in a loop.

o [Effect]: Select the transition effect to be used when moving from one
slide to another. When you click an effect, you can check the effect in
the preview window.

= Aol |

St S S 3

Fietiar bo Main Mars 81

5. click [Start Slide Show].
Click = in the lower right corner to end the slide show.
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You can attach selected still images to an E-mail message.

'0\ To use this function, the e-mail program must be enabled as MAPI
¥ client. For details, refer to the instruction manual of the e-mail
software.

1. Click [Internet] in the Main Window.




3. Select the images you wish to send in the Browser Area and
click [Change Image Size]. IE

You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

| B3 vommovsesany aocumen TN
| B0 B E@ 8
Select Images I L:l 2 My Documents mﬂﬂ m

2 | Brea @)

Lo By E -
— )= Renmovable Disk [F] e
L{] tirkne Siarvces |
Send o Save | w0 e abs || b
. B Bwras Fotaas

4. select image size and quality, and click [Send or Savel.

e If you wish to send the image without changes, select [Send images
unchanged]. Normally select [Resize and compress images into JPEG
format].

¢ [Resize Image]: Select the reduction ratio to the original image.

e [Image quality]: The lower the quality, the coarser becomes the image
and smaller the file size.

e Pressing [Apply] displays the file size after the compression as [Total size
of changed images]:

e You can check the compressed image by pressing [View Images].

- Dipctues - HE]
[624]
2 Large {onginal size)

€ Medum (B0 percent of onginal)
@ Small (30 percent of original)

Image quality & High quality
@ Medum quaidy
@ Low quality

Total size of changed images: ukB

(f] When the image flo size is large, the images may not be sont proporly

Iy your email program: A total file size of 300KB iz recommended
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Attaching Still Images to E-mail Messages

5. Select to send images by e-mail or to save the images in a
folder and click [Finish].

e If you selected [Create a new email], your e-mail program starts and the
selected images appear as an attachment in the message window. Input
address, subject and your comments and send the message. E-mail
programs not supporting MAPI do not start automatically. In this case,
go back to step 5 and select [Save the images in a folder...].

e If you select [Save the images in a folder...] click [Browse] and select the
destination folder. Start your e-mail program and attach the saved
image to a message.

STEP 3. Send the emil or save it tu send later

@ Creale a new gmail

(%) Thiz option is only available if you usg
MAPI, og h_ﬂnr:mﬁ QOutlook Expras

O Save the images in a
that does not 5




PhotoRecord is a printing program. You can use this program to lay out the
still images for printing. You can also create original albums and save them to |E|
your computer.

@ O Do not remove the memory card, detach the USB cable or turn off

\&®  the camcorder while data is being transferred to the printer (when
the camcorder’s card access indicator is flashing). Doing so may
cause memory card data to become corrupted.

O If you are using a network printer and the printer name (including
the network path) exceeds 31 characters, it may not be possible to
print from PhotoRecord. If this happens, open [Control Panel] on the
[Start] menu. Click the [Printers] icon and change the name of the
your printer, limiting its length to within 31 characters.

Movies cannot be printed.

1. click [Print] in the Main Window.

2. Click [Layout Print].

When you have selected [Index Print] and click [Open Index Print], the
Index Print Settings window appears. Select paper size and other settings
and click [Print] to start printing.

33



34

Printing Still Images (PhotoRecord)

3.

Select the still image you wish to print and click [Captions
for Printing].

You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

| I ZOONIRONESER vy e A
87 Dedkiop o ‘\;:. Mrganis i

=) My Documents =
"8""'“‘-“«“" My Dacuments | sebeatan | cluarail |
L{] My Prechans

B My Computer
Ba
Baa () L ==
Biad P
5= Memaovable Disk [ ey, S

L7 Orlne Senncer '

[pen | apout Pont 3 [ sonoo0nans | | o oo |

Fistun 1o Man Menu [io]

Select the image information you wish to.include in the print
and click [Open Layout Print].

e Place a check mark beside the items you wish includ in the print.

e If you wish to add a comment, right-click the mouse button on the still
image, select [Properties] from the displayed menu and type in a
comment.

¢ PhotoRecord starts and the PhotoRecord Print Modes window appears

_cia

all of the properies below,




6. Select paper size and other settings and click [Next]. IE

oHlecard Print Modes

‘s e need b entes e L y
e e e i

T Lk Canon Boidiasiess Prnse
s e [T +]
Tnactstens piﬂ Al

St Page Masgrs_

[ ———. ik @l D) o | % |

7. Select [Automatic Layout] and click [Finish].

The PhotoRecord window appears. If you wish to change the layout,
select the layout in this window.

8. Click [PRINT] in the PhotoRecord window.

e The Print window appears.
e If you wish to save it as an album, select [Save As] from the [File] menu,
select the destination folder and input the file name.

9. Click [Print] in the Print window.
Printing starts.

Hame  [CanonsTs0 x| Fropeie |
Shetut: NAA

Tipe: Canon 5750

Whese  LSIPAND

Comment:

— P, queshly
£ Dialt 1+ Slannded "' High
I Use Cancri Vind Pt
Print rangs [ Eopies
& Al :
pager e[l [T | | tmbecoicopier i 3 ‘

Blark: pages ot e end morit be prrked.
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Printing Still Images (PhotoRecord)

Selecting the Print Layout and Album Design
The PhotoRecord Print Modes window appears when you perform the steps 1

to 4 above or when you click [PRINT MODES] in the PhotoRecord window. Use
this window to select print layout or album design.

1. Select the print mode.

e The available print modes options depend on the printer you are using.
e When you click [Next], a window for selecting the paper size appears.

Artwork/Layout album
You can create a colorful
and fun design. Photofecord P Modes a1

Fixed photo size printing
You can squeeze pictures
into the paper size for printing.

Tiled photo printing
The program lays out and

prints the specified number of ]
images with no gaps between Bl i il
images on the page. —r—

Canon perforated paper printing

2. Select the paper size.
When you click [Next], a window for selecting the layout appears.

Use the preview to
check the print layout.

Frpw Siow mi‘&l

Vﬁ ea]
SetPage Mg

The paper type and size
Enmum ik |[liee ] cwes | b |

options correspond to
the selected print mode.

3. Select the layout.
When you click [Finish], the PhotoRecord window appears.

Photoflecard Print Modes L]
4 The pholos i pous b can be sized ard
Tt e s i o) L
1= Ausomalic lywout ‘H
Select the layout ks et sy
method. irdiond il
B
el
change.
e = | SRR oo s




The PhotoRecord Window

If you click [Save As] on

the [File] menu, you can —Fie Edit &bun View Web Help

save the laid out page
as an album.

Use these buttons to
change how the images
are aligned. Click the
arrow V to display a
pop-up menu.
Change Pago et
{5 Coo Fr o Pt R
Tite 3
AdiTest

Page title

To change the page
title, click ¥ on the left
side of the window
and on the menu that
appears, click [Title]
and [Edit].

Image caption

=[O x|

%% Gwiss Alps_alb - MChotollecord

—{| To change the image
caption, right-click the
image and, on the
shortcut menu, click
[Caption] and [Edit].
Then, type a
description about the
image.

Swiss Alps —

Text box

To add text to the page,
click ¥ on the left side
of the window and on

 insenPage B
ISt foe

Fedayout From Thi Paga On.
Pholo Layouts v

You can drag the
images to move them
to new positions.

Layout

Click this to switch
between auto index and
manual layout mode.

Print Modes

Click this to set the
printing mode or paper

size. |
Fetch Photos

Click this to import still

images.

the menu that appears,
click [Add Text] and
type what you want.
Also, if you right-click
the text box, you can
click [Change Text] on
the shortcut menu and
change its frame or
other artwork.

Image Size

Slide this tab to the left
to shrink the image,
right to expend it.

Stop Fetch
Click this to stop
importing still images.

AUTO TNDEX:

|~ INjm =~ Click this to display Help.

Print
Click this to display the
Print Dialog.

Undo / Redo
Click these buttons to undo or restore
the previous action.

Page Art

Click this to change the
page background or
borders.
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Printing Still Images (PhotoRecord)

o5 O You can add images directly to a page. You simply need to drag the
image that you want from the Browser Display Area of
ZoomBrowser EX to a page in the PhotoRecord window.

O To Change the Page Artwork
Click ¥ and select [Change Page Artwork] from the displayed menu.

O To change the Photo Frame
Click ¥ and select [Change Photo Frames] from the displayed menu.

O Changing the size or rotation angle of an image
Place your mouse pointer over the image that you want to change,
then use the following operations to change its size or angle.

Drag these to Drag this to
change the size I rotate the
of the image. £ image.

Use this button to display a Use this button to switch

menu that helps you between the size and

manipulate the image. rotation options.

You cannot alter the size or rotation angle if you selected [Fixed
photo size] or [Canon perforated paper] as the print mode.

O Changing the number of images on a page
You can change the number of images on one page. On the [Edit]
menu, click [Preferences] and specify the number of images you
want to have on one page of the album.

 Preterences (2]
Set the number e "
of images on b o et e o b ichieg h_-_e-l
one page here. Phl Edic Pl

| Biume..
I+ Iinesge comeclion lun v photos
™ Use Phots Optimezer PR and B Pint
1= Lisn E:al P fioe Eu 2.2 phoins
Ch

shiie
% roseim B3 © Rouchi

Fricting
[ Fird sach pags sepastely
[+ “Bevstiact Pyt b prenfon sl pogies
™ Liss Canon Vivid Phatin for "Trstart Pri™

Ameurd of Finnsion for Pedoeated Papes: 30 men =i
At of Cxtension for Doederless Panting: Laige bt
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Adjusting Image Quality and Printing (Exif 2.2 Compliant)

The PhotoRecord utility features functions that allow you to print images with IEI
image quality adjustments and also supports the Exif 2.2 standard (or Exif

Print). This function automatically selects optimal image correction settings to
produce better prints.

Still images recorded with camcorders complying with the Exif 2.2
standard incorporate recording settings information, such as the
recording conditions and scene mode, along with the image data. The
Exif Print adjustment protocol uses this information to correct the
image quality more accurately to reflect the recording settings.

1. Right-click an image you wish to print and select [Clip/
Correct Photo].

2. Place a check mark beside [Exif Print] or [Photo Optimizer
Pro] and click [Close].

The selected image will be corrected.
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Printing Still Images (PhotoRecord)

Selecting the Print Mode and Number of Copies (DPOF Print Settings)

You can select the image and the number of prints (  print setting) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.

*Digital Print Order Format

’0\ When you are using a SD memory card, make sure the protect switch is
\&¥ set to allow recording.

O You can include the date and file number in the print. Click [Edit] in
the [Edit Slide/DPOF] window and select [Titles].

O The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on
the 201st still image and onward will be erased.

1. click [Set] in the Camera Window and select [Slide/DPOF] in
the displayed menu.

The Edit Slide/DPOF window appears.
& =

2. Select the still image you wish to print, the print mode and
the number of copies.

e [Standard Print]: Prints selected images in the specified number of
copies. Use the arrows next to the boxes below the image to select the
number of copies.

¢ [Index Printing]: Prints selected images-as thumbnails (index). Place a
check mark in the box under the image to include an image to the index.

e [Both (Standard/Index)]: Peforms both standard print and index printing.

Lonnect to mtemet

=

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.



Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping images into a single, seamless

panorama. PhotoStitch automatically arranges still images recorded with the IE
camcorder’s Stitch Assist mode in their correct order and orientation, making

it easy to merge them. Please refer to the Camcorder Instruction Manual to

learn how to record in Stitch Assist mode.

The following instruction explains how to merge still images recorded in Stitch

Assist mode with the camcorder.

70\ Still images recorded in Stitch Assist mode with Wide-converter or Tele-
\&®4 converter attached cannot be merged correctly.

1. cClick the arrow in the Camera Window.

£ CameraWindow

Camcra & Memory Cand

Download imape

View as shidcshow

Cormect o intemmel

J o SR s,

Pttt P ] -— 7
2. In the confirmation window, click [OK].
PhotoStitch starts.

Cal

A D oou want to create a merged image by
uzing the PhotoStitch?

3. Arrange the order of the images and click [2.Merge].
Operational instructions are displayed in the upper section of the window.

)
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Merging Panoramic Images (PhotoStitch)

4. Click [Start].

Mo i | Feerilflrmided Pl Rk e

5. Select [3. Save] and then click [Savel].

e Select the destination folder, input the file name and click [Save].
¢ In the View the Saved Image? window, click [Yes]. The Viewer window
opens and displays the merged image.

O You can record the surroundings in 360 degrees, and stitch them
< together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings. For this, you need to have QuickTime
installed on your computer. If it is not already installed, install it from
the DIGITAL VIDEO SOLUTION DISK. Place the disk in the CD-ROM
drive and click [QuickTime 5.0 Installation] in the installer panel.
O Please refer to the ZoomBrowser EX and PhotoStitch Help menu for
more details.



You can add still images from the computer to a memory card. You can also
add sample images for card mix and card animation from the DIGITAL VIDEO |E|
SOLUTION DISK.

Only still images in JPEG format can be added to the memory card.

Adding Still Images to the Memory Card

1. Click [Camera & Memory Card] in the Main Window.

B[ Deskicp.
uﬂ My Diocuments
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Adding Still Images from Your Computer to the Memory Card

3. Select the images you wish to add and click [Open Camera
Windowl].
You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.

[Add].

¢ The selected images will be re




Adding Sample Images to the Memory Card

You can add sample images for card mix and card animation to the memory IEI
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2

images for CAMERA CHROMA and 4 images for CARD ANIMATION are

provided on the DIGITAL VIDEO SOLUTION DISK.

1. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

2. Click [Camera & Memory Card].

[P ES View Tools Intemel Heb

FOLDERS

B Deskico

15 My Documerts

| L My Friues

B3 5] My Competes

BE E)
bzl (D)
By CanenDVCE0W [E1
(=t Remavabls Dish |F:|
(22 Oniine Services

4. In the Folders Area of the Main Window, select the CD-ROM
icon followed by [DVC CARD IMAGE].

Sample images or folders for CARD CHROMA, CARD LUMINANCE,
CAMERA CHROMA or CARD ANIMATION appear in the Browser Area.

e
T T

1

ii“_‘.?ﬂ




46

Adding Still Images from Your Computer to the Memory Card

5. select the sample images you wish to add and click [Open
Camera Window].

You can select multiple images by continuously clicking on the images.
Click on the image again to deselect.




Adding a Start-up Image to the Memory Card

E]

@ O Image files that do not appear in the [Computer] list of the DVC My
\&®  Camera window cannot be saved to the camcorder.
O Do not detach the USB cable, turn the camcorder power off, or
disconnect the camcorder from the computer while the start-up
image is being saved to the memory card.

1. Click [Camera & Memory Card] in the Main Window.
K
m

wyDocuments [E IEY €3 IEIEETIR |

2. Click [My Camera Settings].
The Select My Camera window appears.

= BAEE EXEN

3. select [My Camera for Digital Video Cameras] and click [OK].

The DVC My Camera window appears, displaying the start-up images
saved on the computer.

Select My Lamera

Select a My Camera type

= My Camera for Digital Cameras
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Adding a Start-up Image to the Memory Card

4. Click [View Cameral.
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5. Confirm that your camcorder model name is selected and
click [OK].

6. Select the start-up image you wish to save to the memory
card from the [Computer] list and click the E button.
e The selected start-up image is displayed in the preview area to the right.
e The file name of the saved start-up image appears in the [Camera] list.
e Start-up images will be saved to the [Dcim] folder in the memory card.

Dt Trpe

[Ernp mage =]

7. Click [Close].

Follow the instructions in Customizing the Camcorder in the Camcorder
Instruction Manual and change the My Camera setting.



Adding New Start-up Images to the DVC My Camera Window

Create a start-up image using an image editing application program. Create IEI
the file in the JPEG format at a size of (w) 320 x (h) 240 pixels.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the DVC My Camera window.

1. Open the DVC My Camera window, and click [Add].

2. Select the file you created in the [Open file] dialog and click
[Open].
* The selected file appears in the [Computer] list.

e You can save the newly created file to the memory card using the
procedures described in Adding a Start-up Image to the Memory Card

(M47).
e To delete a start-up image, select it and click the [Delete] button.
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Setting ZoomBrowser EX to Start Automatically

You can set ZoomBrowser EX to start automatically when you connect the
camcorder to the computer.

Windows 98/Windows 2000

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (1] 16).
When a window appears allowing you to select an application program to
start, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.
If you cannot find the [Scanners and Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall ({7 55).

7. Make sure that your camcorder model is selected and click
[Properties].

8. Click the [Events] tab.

9. Remove the check mark from all programs except
ZoomBrowser EX and click [OK].

The next time the camcorder is connected, ZoomBrowser EX starts and
the Camera Window opens automatically.

FV40, ZR70 M Propesties
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Windows Me

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (1] 16).

When the Scanners and Cameras Wizard opens, click [Cancel].

5. Click the Windows [Start] menu and select [Settings] and
[Control Panel].

6. Double click the [Scanners and Cameras] icon.

If you cannot find the [Scanners and-Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall (00 55).

N

Double-click the icon of your camcorder model.

%

Click the [Events] tab.

9. In the [Actions] section, select [Start this program], set it to
[Canon ZoomBrowser EX] and click [OK].

The next time the camcorder is connected, a window appears allowing

you to select an application program-to start.
ai=
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Setting ZoomBrowser EX to Start Automatically

10.

Select [Canon ZoomBrowser EX], place a checkmark beside
“Always use this program for this action” and click [OK].

e ZoomBrowser EX starts and the Camera Window opens automatically.
e The next time the camcorder is connected, ZoomBrowser EX starts and
the Camera Window opens automatically.

FVAD, ZR70 MC §d |

Device Connected

Sclect the program ta kaunch for thiz action:

Ian Cannn ZnnmEiiwses Fx ﬂ

fv Always use this proam for his sction
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Windows XP

1.

2.
3.

Insert a memory card containing still images/movies into the
camcorder.

Connect the Power Adapter to the camcorder.

Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.
Wait until the card access indicator stops flashing.

Connect the camcorder to the computer using the supplied
USB cable (11 16).
A window appears allowing you to select an application program to start.

Select [Canon ZoomBrowser EX], place a check mark next to
“Always use this program for this action” and click [OK].
The next time the camcorder is connected, ZoomBrowser EX starts and
the Camera Window opens automatically.

[V40, ZR70 MC ZIx

Device Connected

Select the: program bo launch for this achion:
[Canon ZoomBrowser EX
Canon ZoomDiowser £

r "ﬂ Elicrosclt Scanner and Camera Wizard

[] &lways use this program for thiz action
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Uninstalling the Software

Uninstall the software when you wish to delete it from your computer or
when reinstallation is required to fix corrupted files.

'0\ Users of Windows 2000 and Windows XP must first log in as an
\&® Administrator to uninstall the driver and other programs.

Uninstalling ZoomBrowser EX

1. Click the Windows [Start] menu and select [Programs],
[Canon Utilities], [ZoomBrowser EX] and [ZoomBrowser EX
Uninstall].

The uninstall utility starts and removes ZoomBrowser EX.
Uninstall the Camera Window with the same procedure.

o | A S .
2y O If you have uninstalled ZoomBrowser EX because of a corrupt
= database file or other problem, please also delete the Database
folder, which can be found within the [C:\Program Files\Canon\
ZoomBrowser EX] folder.
O PhotoRecord and PhotoStitch can be removed with the same
procedure.

Uninstalling the TWAIN Driver/WIA Driver

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

E]
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Uninstalling the Software

4.

9.

Connect the camcorder to the computer using the supplied
USB cable (1] 16).

A window for selecting an application program or the Scanners and
Cameras Wizard appears, or ZoomBrowser EX starts.

If the window for selecting an application program or the
Scanners and Cameras Wizard appeared, click [Cancel]. If
ZoomBrowser EX started, close it.

Click the Windows [Start] menu and select [Settings] and
[Control Panell.

Windows XP : Click the Windows [Start] menu and select
[Control Panel] and [Printers and Other Hardwarel].

Double-click the [Scanners and Cameras] icon.

If you cannot find the [Scanners and Cameras] icon, see Troubleshooting
the TWAIN Driver/WIA Driver Uninstall ( 1 55).

Windows 98/Windows 2000:

1. Delete the camcorder model name from the [Scanners and Cameras
Properties] list.

2. Click [OK] to close the window.

3. Click the Windows [Start] menu and select [Programs], [Canon
Utilities], [*** TWAIN Driver] and [TWAIN Driver Uninstall].
The model name of your camcorder appears in place of the asterisks
(% x %),

Windows Me/Windows XP:

1. Delete the camcorder icon from the [Scanners and Cameras] folder.

2. Click [OK] to close the window.

3. Click the Windows [Start] menu and select [Programs], [Canon
Utilities], [*** WIA Driver] and [WIA Driver Uninstall].

The model name of your camcorder appears in place of the asterisks
(***).

When the Confirm Uninstall window appears, click [OK].
The uninstall process starts.

10. When the Maintenance Complete window appears, click

94

[Finish].



Troubleshooting the TWAIN Driver/WIA Driver Uninstall

If you had problems uninstalling the driver, use the following procedures to IE'
remove it.

O Use the procedures below for the following circumstances too.
=4 O If you do not find [Scanners and Cameras] in the [Control Panel] or
[Printers and Other Hardware].
O If your camcorder model name does not appear in the [Scanners and
Cameras Properties] or [Scanners and Cameras].
O If you connected the camcorder to the computer via the USB cable
before installing the software/driver on the DIGITAL VIDEO
SOLUTION DISK.

Windows 98/Windows Me

Leave the camcorder connected to the computer.

1. click the Windows [Start] menu and select [Settings] and
[Control Panell.

2. Double-click the [System] icon.
The [System Properties] dialog appears.

3. Click the [Device Manager] tab.

4. If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model and click [Remove].
2. In the confirmation dialog, click [OK].
3. Click [OK] to close the [System Properties] dialog.

5. Double-click the [My Computer] icon on the desktop followed
by the [C:] drive and the [Windows] and [Inf] folders.

If the [Inf] Folder Is Not Visible in the [Windows] Folder

1. Windows 98: Click the [View] menu and select [Folder Options].
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. Windows 98: Set the [Hidden files] section to [Show all files].
Windows Me: Set the [Hidden files and folders] section to [Show
hidden files and folders].

4. Click [OK].

This makes the [Inf] folder and files in the [Inf] folder visible.
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Uninstalling the Software

6.
7.
8.

Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
In the [Inf] folder, double-click [Other] folder to open it.

Find and delete the [Canon.IncCAP_***] folder.
e The model name of your camcorder appears in place of the asterisks

(***).

¢ A window for selecting an application program or the Scanners and
Cameras Wizard appears, or ZoomBrowser EX starts.

e |f the above file is not contained in the [Other] folder, you do not need
to delete anything.

70\ The [Inf] folder contains numerous files that are critical to the
\&® computer’s operation. Be extremely careful not to delete the wrong

files. If you delete the wrong file, you may be unable to restart
Windows.

Windows 2000/Windows XP
Leave the camcorder connected to the computer.

1.

i A WM

Windows 2000: Click the Windows [Start] menu and select
[Settings] and [Control Panel].

Windows XP: Click the Windows [Start] menu and select
[Control Panel] and [Performance and Maintenance].

Double-click the [System] icon.
Click the [Hardware] tab.
Click the [Device Manager] button.

If your camcorder model name appears under the [Other
Devices] and/or [Imaging Devices] categories, use the
following procedures to delete it.

1. Select the name of the camcorder model, right-click the mouse button
and select [Delete].

2. In the confirmation dialog, click [OK].

3. Click [OK] to close the [System Properties] dialog.
Remove all copies of your camcorder model name that appear in the
[Other Devices] or [Imaging Devices] categories, or that appear more
than once in one category.



6.

Windows 2000 : Double-click the [My Computer] icon on the
desktop, followed by the [C:] drive, and the [Winnt] and [Inf]
folders.

Windows XP : From the [Start] menu, click [My Computer],
[C:], [Windows] and [Inf] folders in succession.

If the [Inf] Folder Is Not Visible in the [Winnt] Folder

Use the following procedures to show all files and folders.

1. Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.

3. In the [Advanced setting] section, set the [Hidden files and folders]
category to the [Show hidden files and folders] option.
If [Hide extensions for known file types] is selected, remove its check
mark.

4. Click [OK] to close the dialog.
This makes the [Inf] folder and the files in the [Inf] folders visible.

Look for the file starting with [OEM*].

e A number such as “0” or “1" will-appear in place of the asterisk (*)
above. You will also find another file called [Oem*.pnf], which will have
the same number as the [Oem*] file. The two constitute one set.

e There may be many file sets starting with “Oem".

e If you double-click the [Oem*] file, the Windows Notepad program will
start and show the file contents. Click each [Oem*] file until you find
one that contains “*** Canon Camera Driver Setup File****in its first
line. When you find the correct file, note down its name and close the
Notepad window.

Delete the [Oem*] file set.

Delete all [Oem*] and [Oem*.pnf] files, taking great care to delete the
correct files.

’0\ The [Inf] folder contains numerous files that are critical to the

computer’s operation. Be extremely careful not to delete the wrong
files. If you delete the wrong file, you may be unable to restart
Windows.
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Troubleshooting

-

Cannot download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

Computer does not support the USB interface.

The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.

Requirements: Built-in USB interface on a system preinstalled with one of
Windows 98/Windows Me/Windows 2000/Windows XP.

There is no memory card in the camcorder.
Insert a memory card into the camcorder.

The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

Camcorder is not correctly connected to the computer.

Read Connecting the Camcorder to a Computer (0 16) and check the
connection.

Ensure that you are using the correct cable.and that its connectors are in
good shape.

If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

TWAIN Driver or WIA Driver is not installed properly.

First uninstall the TWAIN Driver/WIA Driver, then reinstall the driver from
the DIGITAL VIDEQ SOLUTION DISK (remove the check marks from the
other programs when prompted to select the programs to be installed). For
uninstalling refer to Installing the TWAIN Driver/WIA Driver ({0 14). For
installing refer to Uninstalling the TWAIN Driver/WIA Driver (00 53).

Cannot install the TWAIN Driver, WIA Driver correctly.

Does the system have a built-in USB port and did it come with
Windows 98 (First or Second Edition), Windows Me, Windows 2000,
or Windows XP preinstalled?

Is the camcorder correctly connected to the computer?
Are you using the AC power adapter to power the camcorder?

If the Problem Is Not Mentioned Above

If the USB TWAIN Driver/USB WIA Driver has not correctly installed,
Windows may not recognize the driver. Uninstall the driver according to
the instructions (0 53) and reinstall the driver.



-

Image files or folders do not appear in ZoomBrowser EX.

Images or folders shown in ZoomBrowser EX and the actual file IE
contents may be different when an image file has been moved or

copied using Windows functions or edited with a separate

program. In such case, click the [View] menu and select [Refresh

Current Folder].

Titles and comments added using a prior version of ZoomBrowser
EX do not appear in ZoomBrowser EX 4.0.

Titles or comments added using a prior version of ZoomBrowser EX

will not be displayed. Use the following procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in
which you installed ZoomBrowser EX 4.0 (C:\Program
Files:\Canon:\ZoomBrowser EX:\Program).

. Double-click [dbconverter.exe].

3. Select the database you were using until now (C:\Program
Files:\Canon:\ZoomBrowser EX:\Program) and click the [Start] button.
Please note that with ZoomBrowser EX 4.0, both titles and comments
appear in the comment list.

N

Cannot find the image folders saved on the prior version of
ZoomBrowser EX 4.0.

Image folders saved under the [Program Files] folder (such as
[Image Library One]) cannot be displayed in the Main Window's
Folder Area of ZoomBrowser EX version 4.0. Use the following
procedure to display them.

1. In Windows Explorer, open the [Program] folder under the folder in
which you installed ZoomBrowser EX 4.0 (C:\Program
Files:\Canon:\ZoomBrowser EX:\Program:\Image Library One).

2. Select the image folder you wish to display and copy the folder to a
different destination.

The images in the folder will be displayed.
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System Requirements

Os: Mac 0OS 9.0-9.2, Mac OS X (10.1/10.2)
Computer Model: Computers that come with above OS preinstalled and
have built-in USB ports.
CPU: PowerPC
RAM: Mac OS 9.0-9.2: 20 MB or more of application memory
Mac OS X (Version 10.1/10.2): 128 MB or more
Interface: UsB
Free Hard Disk Space: Canon Utilities
— ImageBrowser 50 MB or more
— PhotoStitch 30 MB or more
Display: 800 x 600 pixels/32,000 colors or better, 1,024 x 768

(D)

pixels/32,000 colors or better is recommended

O Proper operation is not guaranteed on a user-built PC.

O Proper operation is not guaranteed on any particular system, even if
it meets the requirements outlined above.

O A CD-ROM drive is required to install the software.

O Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

O Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

O Not all operations performed with a connectionto a USB 2.0
compatible board can be guaranteed.



What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained
on the DIGITAL VIDEO SOLUTION DISK. [E]

M ImageBrowser ( (11 65)
¢ Downloading still images/movies recorded onto a memory card to your
computer.
Categorizing and organizing large volumes of still images/movies.
Searching and organizing images chronologically.
Creating mail attachments from still images.
Laying out and printing still images.
Printing indexes.

H PhotoStitch (11 89)
Merging panoramic images.
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Installing the Software

70\ Before you attach the camcorder to the computer with the USB cable
\&® for the first time, you must install the driver from the DIGITAL VIDEO
SOLUTION DISK.

1. Close any programs that are running.

2. Set the DIGITAL VIDEO SOLUTION DISK in the computer’s CD-
ROM drive.

3. Mac 0S 9.0-9.2: Double click the CD-ROM icon, followed by
the [Mac OS 9] and [Canon Digital Video Installer] icons.

Mac OS X (10.1/10.2): Double click the CD-ROM icon,
followed by the [Mac OS X] and [Canon Digital Video
Installer] icons.

The installer panel appears.

4. Select your language.

5. click [Digital Video Software Installation].

Ccanon
Installer Panel

SOLUTION DISK

6. Select the programs you wish to install and click [Install].

Confirm that thereis a check mark beside the name of the program you
wish to install.

Face a check mark beside the programs you wish to install and click the [Install]
button.

Canon Utilities
[ imageBrawser 2.7 Z0MD  mageBroweer Iets you ergasie ad prist oul iges

PltaSHitch rmrges o smries of svar lappireg |mepes |64 8 simgle, seamdess

[=f Photostitch 31 WDt

Back q Install D
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7. Read the license agreement and click [Agreel]. IE

8. Select the installation destination and click [Choose].
Installation starts.

Choose aFolder

I — 0.
Date Modified | &)
a/24s07

Y iscintosn H | Today

4]

I Newu ]" Open II Cancel ]q Choose D
4

9. When the message “Installation has finished.” appears, click
[OK].

10. After the installation is complete, restart the computer as
prompted.
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Connecting the Camcorder to a Computer

70\ O Make sure the camcorder is being powered using the power adapter
\&®  before connecting it to a computer.

O Be sure to install the DIGITAL VIDEO SOLUTION DISK before you
connect the camcorder to the computer.

O Connect the USB cable directly to one of the computer’s main USB
ports. The interface may not function correctly if the camcorder is
connected via a USB hub.

O The connection may not operate correctly if you are using other USB
devices, excluding USB mice or keyboards, at the same time. If this
occurs, disconnect the other devices from the computer and try
reconnecting the camcorder.

O Do not connect two or more camcorders to the same computer via
the USB interface. The connections may not operate correctly.

O Never allow the computer to go into standby (sleep) mode
while a camcorder is connected via the USB interface. If it does
happen, never disconnect the USB cable. Try to awaken the
computer with the camcorder in the connected state. Some
computers will not awaken properly if you disconnect the
camcorder while they are in standby mode. Please refer to your
computer manual for instructions regarding its standby mode.

Insert a memory card containing still images/movies into the
camcorder.

Connect the power adapter to the camcorder.

Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wiait until the card access indicator stops flashing.

Attach the supplied USB cable to the computer’s USB port
and the camcorder’s USB Terminal.
e You do not need to turn off the computer for this procedure.

e Refer to your computer manual for the location of the computer’s USB ports.
e See your camcorder instruction manual for connecting instructions.

USB Terminal USB Cable

on the Camcorder [T | QHHHD E

~&— Camcorder End Computer End —»

USB Port on
the Computer




Downloading Still Images/Movies (ImageBrowser)

Below explains the procedure for connecting a camcorder to a computer using

the USB cable. |E|
For connecting a PC card reader/writer, see Using a PC Card Reader/Writer (L0

71).

@ O Observe following precautions when the camcorder’s card access
\ e /] indicator is flashing (the camcorder is reading or writing from or to
the memory card). Failure to do so may cause memory card data to
become corrupted.
— Do not remove the memory card or detach the USB cable.
— Do not turn off the camcorder or the computer.
— Do not change the position of the POWER switch or the TAPE/
CARD switch.
O Format the memory card with the camcorder or from the Camera
Window (M 73).
O Still images/movies recorded onto the memory card or downloaded
to the hard disk are important original data files. Create a copy of
the file first before working on it on your computer.

Starting ImageBrowser

Mac OS 9.0-9.2

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.
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Downloading Still Images/Movies (ImageBrowser)

4.

Connect the camcorder to the computer using the supplied
USB cable (1] 64).

e ImageBrowser starts and the ImageBrowser Automation Wizard dialog
appears. In the ImageBrowser Automation Wizard dialog, you can
select the action that is carried out after ImageBrowser starts.

e A dialog with the previously selected automated settings will appear the
next time you start ImageBrowser.

1. To use these settings unchanged, click the [Start] button.

2. To do nothing, click [Cancel].

3. To change the settings, click [Settings Change], select the action and
click [OK].

Select [Display Images] and click [OK].

The Communications Settings window appears. This window only
appears the first time the camcorder is connected.

Confirm that [USB port] and your camcorder model name are
selected and click [Set].

The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

%{nmmuwuﬁngs—%

Port: [UsBPort . ]
Detected Camera [W‘IO,;RTDM;( i]
Your camcorder model name
appears here. [cancet ] @ _set D




How to Set ImageBrowser to Not Start Automatically

E]

1. Click the Apple menu ;{; and select [Control Panels] and
[Canon ImageBrowser Auto Launch].

The Settings for USB Connection dialog will display.

2. Click [The application program below will start] to clear the
check mark.

3. Click the close box [ at the upper left to close the dialog.
ImageBrowser will cease to start automatically thereafter.

Click here to close the dialog. —m——= Settings for USB =]

[ The applicationprogram below will start.

Program Name:

Program Selection Options
| O Auto select

& Select with the Dialog
| - Startup Program . 1

Mac OS X (10.1/10.2)

’0\ Do not connect the camcorder while the Classic environment is started.
¥ Likewise, do not start the Classic environment while the camcorder is
connected.

1. Insert a memory card containing still images/movies into the
camcorder.

2. Connect the Power Adapter to the camcorder.

3. Turn the POWER switch to PLAY (VCR) and move the TAPE/
CARD switch to CARD.

Wait until the card access indicator stops flashing.

4. Connect the camcorder to the computer using the supplied
USB cable (1] 64).
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Downloading Still Images/Movies (ImageBrowser)

5.

Double-click the [Canon ImageBrowser] icon on the desktop.

If the Canon ImageBrowser icon does not appear on the desktop, double-
click the [Canon Utilities] folder on the drive on which the program was
installed, followed by the [ImageBrowser] folder and [ImageBrowser] icon.

=
f

Canon 'Image Erowser

Click [Canon Camera] in the Explorer View section.
The Communications Settings window appears. This window only
appears the first time the camcorder is connected.

8086

&3 Canon Camera >
p 5 Macintosn HD ‘

i
Confirm that [USB port] and your camcorder model name are
selected and click [Set].

The Camera Window opens, displaying the camcorder images as
thumbnails (small images).

| anmnnirmm

" pont LUsBPort =
Deteg_t_ggl_'fémera _qub’_zﬁy_ﬁ MC .
f Cancel



Downloading Still Images/Movies to the Computer

VG When using the ImageBrowser’s Camera Window to download images

¥ from the camcorder’s memory card, make sure to select [Macintosh
HD]. The image will not be saved to the computer when [DCIM] is
selected. Follow the instructions below.

1. Mac 0S 9.0-9.2: Select [Macintosh HD] in the explorer view
section.

Mac OS X (10.1/10.2): Select the [{#} (user name)] subfolder
of the [Users] folder in [Macintosh HD].

Eﬁ [“annn "amera
Explorer V|ew Section

2. Create a new folder for saving images from the memory card
in the camcorder.

Click the [File] menu and select [New Folder]. A folder with the name
“Untitled” will be created. Click it to change the folder name as you wish.
In this example, we will input “Z00."

Open.. ®0
Close BEW
Save.. 5
Dupiicas ]
Send to Trash

3. In the Explorer View Section, click the newly created folder.

0= | browserWi

Qi Canun Camera
= = Macintosh HD

@ Applications
Ei canon utiities
C], Desktop Folder
E Documents
m ImageBruwser

vV VY v
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Downloading Still Images/Movies (ImageBrowser)

4. Select still images/movies in the Camera window and click
[DOWNLOAD].

¢ A blue frame appears around the selected still image/movie.
e Downloaded still images/movies are saved to the computer and appear
in the Browser area.

Thumbnail —

SETUP  CONNECT
UPTIONS  CAMERA  DTLECT DOLCTE  |\GOWHLOAL,

| T Win kN BE
= ——
4l Canon Camera 8

= @ Macintosn HOd

100-0002_AUTI0G |,  100-000EAYT.0G

Browser area

=} | camn Sy RECACE [T S
— 1l L TRAI
() ST |

5| — Tulil & bnages |

Explorer View Section

To disconnect the camcorder, click the close box (Mac OS 9.0-9.2) or the red
close box (Mac OS X (10.1/10.2)) at the upper left of the Camera Window.
The Camera Window will close.



o5 O Double-clicking a still image/movie on the camera window imports it
to the computer. |E|
O You can also download still images/movies to the computer by
dragging them from the Camera window and dropping them on the
Browser area or the Explorer View Section.
O You can select multiple still images/movies by holding down [Shift] or
[Option] + [Shift] while clicking.

Using a PC Card Reader/Writer

This section explains only the instructions which differ when connecting a PC
Card Reader/Writer instead of the camcorder.

For instruction on how to connect the PC Card Reader/Writer, please refer to
the PC Card Reader Manual.

1. Insert a memory card into the reader.
Mac OS X (10.1/10.2): If a dialog appears, click the red close box.

2. Double-click the [Canon ImageBrowser] icon on the desktop.

® ImageBrowser starts.

e If the icon does not appear on the desktop, double-click the folder in
which you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

Y

Canar magebratser

3. Double-click the [CANON_DV] and [DCIM] folders in the
Explorer View Section.

The Camera Window opens, displaying the memory card images as
thumbnails (small images).

Explorer View Section

| Browser Wind:

4



Using Other ImageBrowser Functions

Camera Window

The Camera Window opens when a connection to a camcorder is initiated.
Still images/movies will be displayed as thumbnail (small) images (Movies are
displayed with the first scene as a still image, indicated with a movie icon).
Buttons are activated when a still image/movie is selected.

Thumbnail
The still image/movie is
displayed reduced in size.

ZR70 MC =l

— Movie icon

&
&
seTur
oeTIONS

§ o M

SELECT

DELETE

3 B s & @ %
pownLOAD  PRINT FOTATE UFLOAD "I::,";‘ ﬂ;'P';[F’
i

Total 8 mogez ]|

[SETUP OPTIONS]:

[CONNECT CAMERA]:

[SELECT]:

[DELETE]:
[DOWNLOADI:

[PRINT]:

[ROTATE]:

[UPLOAD]:
[IMAGE INFO]:

[SLIDE/DPOF]:

Adjusts the connection settings and camcorder
settings. Menu options: Camera Settings and
Communications Settings.

Reconnects the camcorder to the computer.

Selects still images/movies. Menu options: Select Al
and Deselect All.

Deletes selected still images/movies.

Downloads selected image to the computer.

Prints selected still images. Menu options: Layout
printing and Index printing.

Rotates still images. Menu options: 90 degrees
right, 90 degrees left and 180 degrees.

Adds selected still images to the memory card.
Displays image information (such as shooting date/
time and image size).

The [SLIDE] function cannot be used. [DPOF] allows
you to select the print order settings.

’0\ Mac OS X (10.1/10.2): Be careful when erasing images in the
\&® ImageBrowser Camera Window. Even images you protected with the
camcorder will be erased permanently.
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Camera Setting Window

You can adjust the date, time and owner settings in the Camera Settings IEI
window using the computer when the camcorder is connected. You can also
check the remaining memory card capacity.
1. In the Camera Window, click the [Setup Options] button and select
[Camera Settings] from the displayed menu.
2. Check or change the settings.
Click [OK] to close the window.

Input a camcorder owner name here - TCamera Settings
(up to 31 characters). confer Mouet: canon 2870 MC
Fare | ware Viersion: 00
Set the date and time here. Owner's Name
|_ [Go |
Date & Time

Click this button to synchronize the camcorder ([Ciromuac 7]
to the computer’s date and time settings. _LIWE
M
dn.
Click this to format the memory card —_‘I e
in the camcorder. ‘ \ |
Check the remaining memory card

capacity here. _—- (T

Check the battery status here.
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Using Other ImageBrowser Functions

Browser Window
This section describes the various parts of the Browser Window display.

Explorer View Section Browser Area

Displays the disks and folders This is the area where thumbnails of
that you can use on your still images/movies in the selected
computer. folder are displayed.

If you click the disclosure
triangle on the left edge of the
display, you can switch between
collapsing and expanding the
contents of that folder.

[=]

3 canon Camera
&3 Email Images
= 3 Macintosh HD
W w00
P @ appscations
b T3 Canon Utilities
23 Desktop Foider
b B Documents

Image Name
This is where
the file name

|
1000001 _AUTJRG TO0-DOOE_AUT PG 1OCO003_ALIT JRG

of each
individual
still
image/movie
is displayed.
Movies are
displayed
with_ar)
e movie icon.
S

You can drag this line to Control Panel You can drag this part

change the position of the  This area contains of the frame to

boundary between the buttons that allow change the size of the

Explorer View Sectionand  you to perform a Browser Window.

the Browser Area. variety of functions.

[CANON CAMERA]: Displays the Camera Window.

[SELECT ALL]: Selects all still images/movies in a folder.

[SEND TO TRASH]: Deletes selected still images/movies.

[REDUCE]: Reduces the size of the thumbnails in the Browser

Area.
[ENLARGE]: Enlarges the size of the thumbnails in the Browser
Area.

[DISPLAY IMAGE]: Displays a still image in the Image Viewer window, or
opens a window for playing back a movie.

[PRINT]: Prints selected still images. Menu options: Layout
printing and Index printing.



Image Viewer Window E

The Image Viewer window appears when you double-click a still image, or
when you select a still image and click [DISPLAY IMAGE].

Image B BN 1 S

& £
o I W Enlarge or reduce the
L"'_J i f‘L “@@ image

Current zoom ratio

CROP ADJUST COLOR

You can extract a part of the image. Click here to display the

1. Click on the image and drag to form a rectangular Adjust Color window to
frame. adjust hue, saturation and
You can move or change the size of the frame. lightness of the image by

2. Click this button to extract the area within the dragging the respective slide.
frame.

The extracted part of the image appears.
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Using Other ImageBrowser Functions

Displaying the Image Information
You can check the image information such as shooting date/time or file size.

1. Select the image of which you wish to display the
information.

2. From the [File] menu, select [Get Info].

e The File Information window appears.
e If you wish to add a comment, input it in the [Comment] area.

e Click [OK] to close the window.

Iau Edit View Canon Camera

Open.. ®0
Close L
Save.. xS

MNew Folder WN
Duplicate ®D

Send to Trash

RAW image processing...
Page Selup...

Print »

Multiple Page Print...
Multiols Banes Brint Oolions...

Quit xQ

be displayed.

Hle Mame
100-0001_AUTIPG

Canon ZRT0MC
Shosting Date/Time u
V10902 161508
Image Size
A0
Hie size
13KE

OG-0
DT AF'S Name
—

O It depends on your camcorder model which image information will

O When you modify and save an image using another program,

shooting information or comments may be lost.



[View] Menu

You can select the display settings of the Browser Area from the [View] menu.

Allows you to

CanonCamera Sound Internet Wi

New Browser Window

View Mode

>

View Settings !J File Name

Shooting Date

Allows you to select
the information

E]

enlarge and ?_':“;i"gnme displayed under the
reduce the e Size thumbnails.
:Ihze Og thel =4 :::;r::’:l:fl Allows you to select

umbnails. the operating panel
Allows you to Enlarge e+ displayed below the
enlarge or Reduce %- Browser Area.
reduce the View Actual Image
S'hze Og th?l slide Show...
thumbnails. slide Show Options...

Refresh R

If you select [View Mode] followed by [Preview] from the [View] menu, you
can display a preview of a still image in the Browser Area. To stop displaying
the preview image, select [View Mode] followed by [List] in the [View] menu.

Canon Camera Sound Internet
New Browser window [_
v list

TimeTunnel
Previaw

Enlarge e
Reduce -

View Aclual limage

Slide Show...
Shide Show Dptions...
Relresh #R
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Displaying Images in TimeTunnel

This program displays images in the order of the creation date.

1. In the [View] menu, select [View Mode] followed by
[TimeTunnel].

The image information will be displayed when you point at an image.

VICTN Canon Camera  Sound  Internet

hew Browser Window

View Mode —— The date/time at which the images were shot

LR appears on the red line. You can change this
o [ date/time by double-clicking it on the display.
75 A window similar to the one below appears.
» 100F i i
] Specify the new date/time.
Enlarge x4+ Date Setlings
Reduce -
View Actual Image CJ Find and Show Kem Move the slider up
stide Show... o or down to move
Slide Show Oplions.. E baCkWard or
Befresh L (o) forward in time.
4] Brow )cr'l\“imluw - = L

(53 Canon Camera C)!

= & Macintosh HD

bW zo0

3 [# aApplications

¢ G Canon Utilities
[ ODesktop Folder

b B Documents
i imagrBrowser

Display Tool Panel
Aule Cruise

Switch to Browser View

T el I

Makes the Double-click a thumbnail
Tool Panel TimeTunnel rings to display it in another window.
octagonal.
=l | Click to display the control panel.
117/9/02 Hﬁ.’..".:;:'.mnn musa;jl [Display Tool Panel]:
L il | Select to display or hide the tool
panel.
Changes the number  [Auto Cruisel:
of TimeTunnel rings.  ~ Enables or disables [Auto Cruise].

When [Auto Cruise] is active, the time

movement continues even after you

have moved and released the bar.
[Switch to Browser View]:

Exit TimeTunnel, and returns to the

previous screen.

Allows you to Makes the
specify the date TimeTunnel look
for the images  curved.
displayed.



Playing Back Movies From a Memory Card

In the Camera Window and Browser Area, movies are displayed with the first
scene as a still image with a movie icon ( ## ). When you double-click the

thumbnail in the Browser Area, QuickTime Player starts and plays back the
movie.

1. In the Browser Area, double-click a thumbnail with a “#
(movie) icon.

QuickTime Player starts.
0

| Browser Window (2]=]

[} Canon Camara
3 Email Images
= = Macintosh HD
W oo
b [@ Applications
b [ canon Utilities
u Desklop Folder
I i Documents

100-0001 _ALT.IPG 100-0007_AUT.IRG 100-0003_AUT.IPG

100-0004_AUT.JPG 101-0128_101.AVI

2. Click the > (play) button in QuickTime Player.
The movie will be played back.

STROEEE >
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Running a Slide Show

1. From the [View] menu, select [Slide Show Options].

2. Select the slide show settings and click [OK].

m Canon Camera 5o

Mew Browser Window
View Mode »
View Settings »
3
S0P
5%

¥ 1007
200°
Enlarge ®+
Reduce 8-
View Actual Image
Slida Chaur
Slide Show Options..
Refresh =R

e [Auto Play]: Moves to the next still image automatically. Select the
interval by sliding the control under [Play Interval] (from 1 to 30

seconds).

e [Control with Mouse or Keypad]: Advances the slide show manually

with the mouse or keyboard.

e [Repeat Continuously]: Runs the slide show in a.loop.

¢ [Hide buttons]: Hides the buttons during the slide show.

e [Transition Effect]: Select the transition effect to be used when moving
from one slide to another. When you select an effect, you can check the

effect in the preview window.

Slide Show Optlons =

Play Method
[ & Auto Play

(] Repeat Continuously
Hides buttons
il o

Transition Effect

Random

Play Interval = 1 Se

3 Control with Mouse or Keypad

@

e ——

:

3. Select the images and select [Slide Show] from the [View]

menu.

Click £ on the lower right of the screen to end the slide show.
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Attaching Still Images to E-mail Messages

You can attach selected still images to an E-mail message.

1. Select the images you wish to send in the Browser Area.

2. From the [Internet] menu, select [Create Image for Email].

Window_Help

Create Image for Email... —

Canon Digital Camera Web Site. ‘I

3. Specify the image size and click [Next].

Select this if you do not wish to

reduce the size of the still image. —

Create lmage for Email

l:renle an Imlue file lnn appropriate size for sending as an email
Litis to keep the total size les:

than FOOKL. thoose onuun and click [Next].

{1 Send image(s) without compression

Normally, select this option.

Hesize and I JPEG format
Number of images:1
Total Size Before Compressian:7OKE
=

4. specify the reduction ratio-and image quality and click

[Next].

e [Resize (%)]: Select the reduction ratio relative to the original size of the

image.

e [Quality]: Select the image quality. The lower the quality, the rougher

the image becomes, but the size of the file also becomes smaller.
e [Compress]: Use it to check the file size when you actually compress the
image. The file size appears next to “Total Size After Compression”.

_' Create Image for Email

Set reslzlnl and quality Tactor. Cick [Compress] to compress images. In
general I,itis recommen ded Lo keep the total size less than J00KB.

Resize(®=):
Quality: =@= [compress ]

wumber of Images:1
Total 5ize Before Compression:/OKD
Total Size After Compression:

< Previous Cancel
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Attaching Still Images to E-mail Messages

5. Select whether you wish to start your e-mail program and

click [Finish].

e If you have selected [Start email application after closing], your e-mail
program starts automatically. Open a new e-mail message and attach
the image. With Outlook Express or other types of e-mail programs, you
can attach images to e-mail messages simply by dragging them from
the Browser Area to the new message window.

e Click [Preview] to check the changed image.

e The image will be saved to the [Email Images] folder in the explorer

view section.

Create lmage for Email

Uick the [Finish] buttan. Ihe image for attaching to an email message
will display in the Browser Window. Attach this image Lo your emai il
message.

E4 start email application after closing

Humber of iImages:1
Total 5ize Before Compressian:ioKks [_Preview |
Total Size After Compression:T4KB.

e - eeee

Explorer View Section -

Eﬁ Canon Camera

@ Emailimages

[ = Macintosh HD

O You can set the e-mail program to start automatically in step 5. Note
that some e-mail programs may not start automatically.
Mac OS 9.0 ~ 9.2: From the Apple menu, select [Control Panel],
followed by [Internet] and click the [Email] tab. Change the setting in

the displayed window.

Mac OS X (10.1/10.2): From the Apple menu, select [System
Preferences], followed by [Internet] and click the [Email] tab. Change
the setting in the displayed window.

O The images in the [Email Images] folder are saved in the following

location:

Mac OS 9.0 ~ 9.2: Open the disk you installed ImageBrowser or the
[Documents] folder, followed by [ImageBrowserUserData] and [Mail].
Mac OS X (10.1/10.2): Open the [Users] folder, followed by [User
login name], [Library], [Preferences], [ImageBrowserUserData], and

[Mail].



Printing Still Images (ImageBrowser)

You can select the layout when printing still images.

Do not remove the memory card, detach the USB cable or turn off the
camcorder while data is being transferred to the printer (when the
camcorder’s card access indicator is flashing). Doing so may cause
memory card data to become corrupted.

=)

1. Select the still image(s) you wish to print in the Browser
Window.

Movies cannot be printed.

2. Click [PRINT] and select [Layout printing] from the displayed
menu.
e The Layout Options window and Print window appears.

e If the Layout Options window does not appear, display it by clicking
[LAYOUT OPTIONS] in the Print window.

Print Window
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Printing Still Images (ImageBrowser)

3. In the Layout Options window, select a layout and click

[Next].

The Custom Layout printing option allows you to freely change the size
and position of the still images for printing. The other options allow you
to print an index or print onto Canon perforated paper. Canon perforated
paper cannot be selected with Mac OS X (10.1/10.2).

Layout Options Window

Layaut Options

Haw would you like to print your phatosi
& Custom layout printing

O Index printing

3 Fied photo size printing

O Tiled phote printing

) Canon perforated paper printing

Prints each image at the individuaity
specified size and position.

4. Select a paper size and click [OK].
e The Print window opens, allowing you to change the layout and

printing settings.

e The settings available will vary according to the type of layout selected

in Step 3.

A Layout dptiens 0
L Preview
Contirm the page setup.
Bapersize:
Wertical 11,69 Harizantaln. 26in
o the
(@] [ canest | [ emack | [

5. Click [PRINT] in the Print window.

The Print dialog appears.

6. Click [Print].
Printing starts.

EEEEEENE
Brol avnllT  ROTATE IMAGES LaYnuT
RF-L i ROTATE. e (T FRIND :




The Print Window

Print

Edit the Page Title

Landscape in Europe

Change the Image
Size

Drag the border to
resize the still image.

Open the [Edit]
menu and select
[Edit Header].

Lk o Wt
etheiands

e sl Wi Rkt W i,

Change the Layout
Drag the still
image to change
the layout.

Add Text

Open the [Edit]
menu and select
[Add Text].

Change the default:
number of still
images printed per
page.

Click this to rotate
the selected still

Click this to reset
the layout.

Add Captions to Still
Images

Click the still image
and then the [Edit]
menu and select
[Edit Caption].

[l & —— dlick this to display

FRINT

the Print dialog.

-l
Click this to select

a layout type.
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Printing Still Images (ImageBrowser)

Adjusting Image Quality and Printing (Exif 2.2 Compliant)

ImageBrowser allows you to print images with image quality adjustments.
ImageBrowser also supports the Exif 2.2 standard (or Exif Print).

O Still images shot with camcorders complying with the Exif 2.2
standard incorporate shooting settings information, such as the
shooting conditions and scene mode, along with the image data.
The Exif Print adjustment protocol uses this information to correct
the image quality more accurately to reflect the shooting settings.

O When printing from ImageBrowser, the image quality adjustment
settings are active for all images.

fo)
24

Mac OS 9.0-9.2

1. click the [Edit] menu in ImageBrowser and select
[Preferences].

View Canon Camera Sound  Intes

&

TN R
i

- Ameras.
My Camera for Diaital Video Cameras...

2. In the Preferences window, select [Print], set the image
quality settings and click [OK].

See Printing Still Images for the next steps (1 83).

Cancel

A check mark must be placed here to —

automatically correct the image —a
quality' ' Ilﬂmll-ﬂn.lin(lﬂml

Select this option to automatically R

correct images shot with Exif 2.2 Clrwe Name

compliant camcorders and For Dbie et Prater)
other.images. I?! e

Select this option to automatically

correct only images shot with Exif 2.2 omuteion ] Onenone G

compliant camcorders. i it

upended.




Mac OS X (10.1/10.2)

1. Click the [ImageBrowser] menu in ImageBrowser and select

[Preferences].
IRECEHGITUTTE File  Edit

About ImaneRrowser...

[ Preferences... )

Services >

Hide ImageBrowser 3H
Hide Others
Show All

Quit ImageBrowser 380

2. In the Preferences window, select [Print], set the image
quality settings and click [OK].

See Printing Still Images for the next steps (1 83).

A check mark must be placed here to

automatically correct the image
quality. J ‘
Select this option to automatically
correct images shot with Exif 2.2
compliant camcorders and other
images.

Select this option to automatically ——
correct only images shot with Exif
2.2 compliant camcorders. ‘

B Rotase Lan - © Rotts Right l
Salegt the direton of rotaten for mapes shut with (v €amer s
| wpendes

| | Image Conection .
=)
- Bshwocng pare : |
B shooting Teme
i arme

Cafault Print Window Birection of Retatien

ot csate Loft] ce [Ratate Righe] ta rotate the By 90 degress om
FespeLi ammera

the e irection as viewsd from befind the ¢
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Printing Still Images (ImageBrowser)

Selecting the Print Mode and Number of Copies (DPOF Print Settings)

You can select the image and the number of print (™ print settings) for
automatic printing on a DPOF*-compliant printer. You can set the DPOF print
settings also on the camcorder.

*Digital Print Order Format

ma\ \Vhen you are using a SD memory card, make sure the protect switch is
\0‘ set to allow recording.

o O You can include the date and file number in the print. Click [Edit] in
" the [Edit Slide/DPOF] window and select [Titles].

O The Edit Slide/DPOF window allows print settings on up to 998 still
images. With some camcorders, DPOF print settings are limited to a
maximum of 200 still images. In that case, all DPOF print settings on
the 201st still image and onward will be erased.

1. click &h (SLIDE/DPOF) in the Camera Window.
The Edit Slide/DPOF window appears.

2 moME=—=—— ¢

pOWNLOAD  FRINT

8 @

.:&;,
MaE

FOTATE  pgGAB

2. Select the still image you wish to print, the print mode and
the number of copies.

e [Standard Print]: Prints selected images in the specified number of
copies. Use the arrows next tothe boxes below the image to select the
number of copies.

e [Index Printing]: Prints selected images as thumbnails (index). Place a
check mark in the box under the image to include an image to the index.

e [Both (Standard/Index)]: Performs both standard print and index printing.

Cdit Slide/DPOF - TRT0 MC

@ =] @ a

Taew ta Carwra Ean wy un

3. Click [Save to Camera].
The DPOF print settings will be saved to the memory card.



Merging Panoramic Images (PhotoStitch)

You can merge a series of overlapping images into a single, seamless

panorama. PhotoStitch automatically arranges still images recorded with the |E|
camcorder’s Stitch Assist mode in their correct order and orientation, making

it easy to merge them. Please refer to the Camcorder Instruction Manual to

learn how to record in Stitch Assist mode.

The following instruction explains how to merge still images recorded in Stitch

Assist mode with the camcorder.

70\ Still images recorded in Stitch Assist mode with Wide-converter or Tele-
\&®4 converter attached cannot be merged correctly.

1. Click the green stitch mark in the Camera Window.

b= — ZRTOMC = =B

Ei;v Lil q»\ IM‘

" e,
PG CAERA O SRETENN RAGLORDIN, T

g — P

2. In the confirmation window, click [Yes].
PhotoStitch starts.

]c__ This image was shat in Stitch Assist moade.
d Would you like to merge it now?

JG=D

~ =

3. Arrange the order of the images and click [2.Merge].
Operational instructions are displayed in the upper section of the window.
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Merging Panoramic Images (PhotoStitch)

4. Click [Start].

5] B  Photestitets BB

Merge Images
ik [Start] 1o bagn merging.

5. select [3. Save] and then click [Save].
e Select the destination folder, input the file name and click [Save].
e In the View the Saved Image? window, click [Yes]. The Viewer window
opens and displays the merged image.

2% O You can record the surroundings'in 360 degrees, and stitch them
&~ together later to form a 360-degrees cylinder. (In [1. Selection and
Arrangement], select [Arrange] and [360 degrees].) By saving this
stitched image in QuickTime VR format, you can then get a virtual
view of the surroundings.
O For more details, please refer to the ImageBrowser and PhotoStitch
Help menu.
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Adding Still Images from Your Computer to the Memory Card

You can add still images from the computer to a memory card. You can also
add sample images for card mix and card animation from the DIGITAL VIDEO
SOLUTION DISK.

O O Still images in JPEG, TIFF, PICT, and Windows bitmap format can be
= added to a memory card. However, the still images will be saved in
JPEG format on the memory card.
O You can also add still images to a memory card by using drag and
drop to move it from the browser area to the Camera window.

Adding Still Images to the Memory Card

1. In the camera window, click [UPLOAD].

= ZRTOMC = -H

G @ g0 :ﬁ 3 Eb
u:lll.;b ‘Bmm SILCCT DELETC. | DOWNLOAD PRWT

&:O I\

2. Select the still image you wish to add and click [Open].

You can check the selected still image by clicking [Show Preview] in the
[Select images to add] window.

il Selecti to add ]
——
(B oesktop 2] ajalo]
Dale Mudified |2
= =3 Macintosh HD Today _
v (3 mreve Today L
[ J1nn-noni_aut e [AFAkTi kS
& 100-0002_AUT.JPG 11413702
58 100-0003_AUT.JPG 1302 |0
B 1nn-nnnd &AUT PG 1113607 %
e
(] Copen 2

E]
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Adding Still Images from Your Computer to the Memory Card

3. Select the image size.

e Confirm that your camcorder model name is displayed under [Camera
model].

¢ [Image Size]: Select [large] or [Small].

e [Adjust Height] and [Adjust Width] specify the standard for image
enlargement and reduction.

e Still image enlargement and reduction are not performed when both
[Adjust Height] and [Adjust Width] are deselected.

e When [Adjust Height] and [Adjust Width] are both selected, the aspect
ratio of the still image (the ratio between the height and width of the
image) may change when the still image is resized.

e \When you have selected multiple images in step 2, [Save subsequent
images with the same settings] will be activated. Click this button to
apply the current settings to subsequent images.

4. Click [Save to Cameral.

e The selected images will be recorded to the memory card.
e \When recording is complete, the images will appearin the Camera

WindOW. [ o sweto camera - Zwe

11 Images
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Adding Sample Images to the Memory Card

You can add sample images for card mix and card animation to the memory IE'
card. 4 images for CARD CHROMA, 2 images for CARD LUMINANCE, 2

images for CAMERA CHROMA and 4 images for CARD ANIMATION are

provided on the Canon DIGITAL VIDEO SOLUTION DISK.

1. In the camera window, click [UPLOAD].

EH= - ZRTOMC = =B

SENP ATINETT n M SLI0ES
UPIRRE  Careka  SCLECT B i mry oHUF

Total: 2 images [

2. Insert the DIGITAL VIDEO SOLUTION DISK to the computer’s
CD-ROM drive.

3. Double-click the CD-ROM icon, followed by the [DVC CARD
IMAGE] folder.

The folders [CARD CHROMA], [CARD LUMINANCE], [CAMERA CHROMA]
or [CARD ANIMATION] appear.

Is —_— Wages to add =]

8 Desttop : alnjo]
Dale Modified |2

(@) CanonbvrE0r 9/24/02
- o240z |2

I» [} CAMFRA CHROMA RiZAN?

I (3 CARD ANIMATION 624702
3 (3 CARD CHROMA 6/24/02 E
3 (5§ carn LuriHaNCE arzamz
@) Cancel | open |
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Adding Still Images from Your Computer to the Memory Card

4. Open the [CARD CHROMA], [CARD LUMINANCE], [CAMERA
CHROMA] or [CARD ANIMATION] folder, select the image
you wish to copy to the camcorder and click [Open].

Selectimages to add

= Desktop = E O

Dale Modified |2
= (2} CanonDVCE0M 9424702
= [ ovecaRD IMAGE 6/24/02 =
= [ cariFRa CHRAMA fizam?
I {u1_0118.F¢] 624702 [
19 AUT_0119.0FG 6/24/02
3 3§ carn amiraTion arzamz
: P

5. Set [Image Size] to [Smalll.
e Confirm that your camcorder model-name is displayed under [Camera
model].
e When you have selected multiple images in step 2, [Save subsequent

images with the same settings] will be activated. Click this button to
apply the current settings to subsequent images.

11 Images

[ Adjust Helght

- & Adjust width
Camera M fode! [ TR0 ML

6. Click [Save to Cameral.

e The selected images will be recorded to the memory card.

e When recording is complete, the images will appear in the Camera
Window.

settipgs | | Cancel

{ save to Camera )




Adding a Start-up Image to the Memory Card
Adding a Start-up Image to the Memory Card

VG O Image files that do not appear in the [Computer] list of the DVC My
\&®  Camera window cannot be saved to the camcorder.
O Do not detach the USB cable, turn the camcorder power off, or
disconnect the camcorder from the computer while the My Camera
Settings is being saved to the camcorder.

1. From the [Edit] menu in the Browser Window, select [My
Camera for Digital Video Cameras].

The DVC My Camera window appears. [EDH view Canon camera soundtnter
T
Cut ®X
Copy W
Paste v
e ag

select All xA
| Desclectai

Rotate »
Add Text...

EditHearer,

EdiECaptinn..

Cipping...

L Gopy Imane...

Arap
AdjustColor...

Afdobe PRotoshop...
iration

2. Click [View Cameral].

1 S0P
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Adding a Start-up Image to the Memory Card

3. Select the start-up image you wish to save to the memory
card from the [Computer] list and click the [=1 button.
e The selected start-up image is displayed in the preview area to the right.

e The file name of the saved start-up image appears in the [Camera] list.
e Start-up images will be saved to the [Dcim] folder in the memory card.

DVC My Camera

Data Type | Start-up Image &

Computer Camera
221 iolipg
321 viblipg o

ANIMALDZZ VIOLIPG
ANIMALOZY VIDLIPG
BARZ1_YI01IPG

BASCRAI 1 VAR 1P
CTHOANCEZ T ¥ s
ETHTECHNZ T VI01.1PG
FUNZI VIDLIPG

Add Delete l

Delete

DII:'

4. click [Close].

Follow the instructions in Customizing the Camcorder in the Camcorder
Instruction Manual and change the My Camera setting.



Adding New Start-up Images to the DVC My Camera Window

Create a start-up image using an image editing application program. Create IE'
the file in the JPEG format at a size of (w) 320 x (h) 240 pixels.

Once you have created the start-up image and saved it to the computer, use
the following procedures to add it to the DVC My Camera window.

1. Open the DVC My Camera window, and click [Add].
verervrorors . .
e

2. Select the file you created in the [Open file] dialog and click
[Open].
¢ The selected file appears in the [Computer] list.
* You can save the newly created file to the memory card using the
procedures described in Adding a Start-up Image to the Memory Card
(@ 95).
e To delete a start-up image, select it and click the [Delete] button.

mn RITTNTS
ETHTECHNZ1 VI01.0PG

The newly added data will
appear here \|m:ﬁ: - Delete
FUNZI VIO PG
FUNZ4 VIDLIPG.

GAKKIZ1 VIO PG
GAMEZ]_VINT IPG

GAMEZ? VI01IPG
..
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Uninstall the software when you wish to delete it from your computer or
when reinstallation is required to fix corrupted files.

Uninstalling ImageBrowser and PhotoStitch
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser and PhotoStitch.

’0‘ If the program folders contain subfolders into which still images/movies
¥ have been saved, be careful not to accidentally delete those subfolders.

&




Troubleshooting

This topic explains some of the causes for and solutions to problems with the

software. |E|

Cannot download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

=» Computer does not support the USB interface.
The USB interface is not supported for computers not in compliance with
the following requirements. Acquire the necessary system to use the USB
interface.
Requirements: Genuine Apple Computer brand computer with a built-in
USB interface.

=>» There is no memory card in the camcorder.
Insert a memory card into the camcorder.

=> The camcorder is not set to the correct mode.
Slide the POWER switch to PLAY (VCR) and the TAPE/CARD switch to
CARD.

=» Camcorder is not correctly connected to the computer.
Read Connecting the Camcorder to a Computer ({3 64) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in
good shape.

=» If you are experiencing operational problems, detach the USB cable
from the camcorder and computer and terminate the connection.
Restart the computer and then reconnect the camcorder.

Image files or folders do not appear in ImageBrowser.

=» The image files may not be updated. In such case, click the [View]
menu and select [Refresh].
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